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UNIT-I 

A) An introduction to the World Wide Web 

i) Concepts of web technology:-  

If you are planning to maintain a Web site then I'm listing few basic skills which you will require 

to build and maintain a Web site. This list may go to infinite because today there are numerous 

technologies available and many are coming every day. So you have to plan and affirm on any 

one of the available technologies and go ahead for your project. 

This is not required that you should have knowledge of all the listed skills. If you want to 

develop a simple Web site then you would needs just first four skills listed here. Rest of the skills 

are required if you want to go for a bigger and more interactive Web site. 

• Computer Operations: All you need to know is how to operate a computer - Windows, 

Linux or Macintosh. This depends on which Web Server you want to host your web site. 

So you should have basic knowledge of that system only. You should be well acquainted 

of basic operations like creating file, deleting file, updating file, directory creation, file 

permission etc. 

• Remote Access: Most of the times your Web Server will be accessed from remote site 

only. You should be well aware how to connect a computer from remote site. So at least 

you should have basic knowledge of telnet utility to connect to a remote machine. There 

are many service providers who will provide you control panel to manage your Web site. 

• File Uploading & Downloading: As I told you most of the times your Web Server will 

be on remote site. So you would need to upload and download all the files related to your 

Web site. So at least you should have basic knowledge of FTP utility to connect to a 

remote machine and download or upload your files. Almost service providers give you 

facility to upload your files on your Web server. 

• HTML / XHTML Knowledge: These are the markup languages which you will use to 

build your web site. So you should have good understanding on these languages. You can 

refer our tutorial to learn HTML / XHTML. 

• CSS Knowledge: Cascading Style Sheet knowledge is required to achieve many results 

which are not possible through HTML or XHTML. 

• PHP Script: Now a days many sites are being developed using PHP language. This 

script helps you to create an interactive Web site. You can refer our tutorial to learn PHP 

Script. 



 
• PERL Script: PERL is another language which is being highly used to develop 

interactive Web Applications. So if you are planning to use PERL to develop your Web 

site then you can refer our tutorial to learn PERL Script. 

• Java or VB Scripts: These scripts are required to perform user level validations and to 

add more interactivity in your Web site. So a web developer is desired to have knowledge 

of any of the client side scripts. 

• AJAX Technology: This is the latest technology in the web. Google and Yahoo are 

using this technology to give a better browsing experience to their site visitors. You can 

refer our tutorial to learn AJAX Technology. 

• ASP or JSP : These are another technologies to be used to develop interactive Web sites. 

• Flash Knowledge: You can plan to use Macromedia Flash to build your Web site. This is 

a bit time consuming to learn this technology but once you learnt then you can develop 

very beautiful and attractive web sites using Flash. 

• HTTP Protocol: As you grow you are desired to have more knowledge about Web. So I 

would suggest you to go through the web backbone i.e. HTTP protocol as well. You can 

refer our tutorial to learn HTTP Protocol. 

 

ii) Web browsers: - Web Browsers are software installed on your PC. To access the 

Web you need web browsers, such as Netscape Navigator, Microsoft Internet 

Explorer or Mozilla Firefox. Currently you must be using any sort of Web 

browser while you are navigating through my site tutorialspoint.com. On the 

Web, when you navigate through pages of information this is commonly known 

as browsing or surfing. 

iii) Internet & Intranet:-  

The Internet is essentially a global network of computing resources. You can think about the 

Internet as a physical collection of routers and circuits as a set of shared resources or even as an 

attitude about interconnecting and intercommunication. Some common definitions given in the 

past include: 

• A network of networks based on the TCP/IP communications protocol. 



 
• A community of people who use and develop those networks. 

• A community of people who use and develop those networks 

Intranet is system in which multiple PCs are networked to be connected to each other. 

• PCs in intranet are not available to the world outside of the intranet. 

• Usually each company or organizations have their own Intranet network and 

members/employees of that company can access the computers in their intranet. 

• Each computer in Intranet is also identified by a IP Address which is unique among the 

computers in that Intranet. 

iv) Protocols the TCP/IP,HTTP,FTP,SMTP 

HTTP:- This stands for HyperText Transfer Protocol. This is the protocol being used to transfer 

hypertext documents thats makes the World World Wide possible. 

A standard web address such as http://www.yahoo.com/ is called a URL and here the prefix http 

indicates its protocol 

FTP:- Allows a user to transfer virtually every kind of file that can be stored on a computer from 

one Internet-connected computer to another. 

TCP/IP:- TCP/IP is shorthand for a suite of protocols that run on top of IP. IP is the Internet 

Protocol, and TCP is the most important protocol that runs on top of IP. Any application that can 

communicate over the Internet is using IP, and these days most internal networks are also based 

on TCP/IP. 

Protocols that run on top of IP include: TCP, UDP and ICMP. Most TCP/IP implementations 

support all three of these protocols. 

SMTP:- This stands for Simple Mail Transfer Protocol Server. This server takes care of 

delivering emails from one server to another server. When you send an email to an email 

address, it is delivered to its recipient by a SMTP Server 



 
B) Planning your web site 

i) Doing business on the web:-  

Ecommerce is a way of doing business through Internet. Specially when you are 

selling your product or services through Internet then you are doing ecommerce. 

So if you planning to put a web site which will have transactions likes buying or 

selling items or services then it means you are going to setup an ecommerce web site. 

If this is the case then I don't think this guide will help you upto a level where should 

be able to setup an ecommerce site because there are many more things which should 

be considered while setting up an ecommerce web site. 

Still you can start from here : E-commerce hosting are bit expansive but they should 

not be treated as expansive that you can not start an ecommerce web site. Now a days 

it is very easy to set up an ecommerce site only thing is that just get in touch of any 

good service provider and start gathering basic information. 

There many service providers who help you to setup your virtual store and charge you 

unexpectedly very low. Even now google also has started google account service in 

which you can sell your products through them and all the money will come in your 

account without any hassle. 

 

ii) An overview of internet commerce providers 

Many companies seek to increase their online visibility because of the benefits 

associated with a strong online identity. Businesses with considerable financial gains 

are also the ones with a higher rate of web-based customer acquisition. A higher 

percentage of their revenue comes from online transactions as well.1  

At the same time, e-commerce and online shopping present unique challenges. 

Customers associate online shopping with opportunism, absence of control, and a 

greater degree of anonymity and uncertainty. There is little assurance that the services 

or products offered will be of the same quality as those advertised online.2  

This white paper suggests that the problem of lack of trust can be dealt with by 

finding effective channels for promotion and publicity. Familiarity builds trust, and 

potential customers are more willing to transact online. One of the effective ways to 

achieve this is through listing one’s company with a local business directory. The 

paper also argues that business directories offer advantages over offline promotion. 

They are an effective means of gaining exposure, building trust, and establishing a 

strong online presence. 



 
iii) A search engine:- Search Engine is the activity of optimizing Web pages or whole 

sites in order to make them more search engine friendly, thus getting higher positions 

in search results. This tutorial will teach you simple SEO techniques to improve 

visibility of your web pages for different search engines specially for Google, Yahoo 

and Bing. 

iv) Forming a project team:- A project team is a group that works together to execute 

the tasks necessary to meet customer requirements. Before a project team meets for 

the first time, before they start "forming, storming, norming, or performing," or 

maybe even before they know they will be working together, the project manager 

begins laying the foundation for effective teamwork. 

v) Setting goals & objectives:- Setting goals and working toward them can help you 

turn your dreams into reality. Goals are things you set to accomplish either in a long 

period of time or a short period of time. 

1. Short Term Goals: These are goals that you can accomplish within a short period 

of time, i.e. 3 days or 2 weeks. 2. Long Term Goal: These are goals that you can 

accomplish within a long period of time, i.e. 6 months or 5 years. 

vi) Developing the right business strategy:- Helping a client to define its true value 

proposition and using that knowledge to innovate the business model so that existing 

customers can be better served and share of markets can be extended is one of the 

roles of any Growth Coach. Developing effective strategy requires directors and 

senior managers exploring their value statements and learning how use tools like the 

Organizational Value Quadrant (OVQ)
1
 model.The four quadrant tool helps to define 

distinct operating models that relate a company’s positioning relative to the markets 

served by the business. Knowing which quadrant a client’s business operates in and 

understanding how to navigate within the OVQ form the foundation of all strategic 

plans. So, what are the four organizational value quadrants, and what do they mean to 

a business in terms of strategy and investment. 

C) HTML 

i) What is HTML:- HyperText Markup Language (HTML) is the main markup 

language for creating web pages and other information that can be displayed in a web 

browser. HTML is written in the form of HTML elements consisting of tags enclosed in 

angle brackets (like <html>), within the web page content. HTML tags most commonly 

come in pairs like <h1> (opening tag) and </h1>(closing tag), although some tags, known 

as empty elements, are unpaired, for example <img>. The first tag in a pair is the start 

tag, and the second tag is the end tag (they are also called opening tags and closing tags). 

In between these tags web designers can add text, tags, comments and other types of text-

based content. The purpose of a web browser is to read HTML documents and compose 

them into visible or audible web pages. The browser does not display the HTML tags, but 

uses the tags to interpret the content of the page. 

ii) HTML basics:-  



 
           HTML headings are defined with the <h1> to <h6> tags. 

              HTML paragraphs are defined with the <p> tag. 

              HTML links are defined with the <a> tag. 

              HTML images are defined with the <img> tag. 

iii) Document tags:- Document tags define the overall structure of an HTML document. 

There are four tags every HTML document should have. These tags define the what type 

of document it is, and the major sections. These tags are <HTML>, <HEAD>, <TITLE>, 

and <BODY ...>. You may also wish to use the <!DOCTYPE ...> declaration under some 

circumstances.  

iv) Container and empty tags:- There are two kinds of tags: container and empty.  

The container tag always wraps around text or graphics and comes in a set with an 

opening and a closing: 

<html> opening tag 

</html> closing tag 

Notice the forward slash (/) on the closing tag. This tells the browser that the tag has 

ended. 

On the other hand, the empty tag stands alone. The tag <br> is one that adds a line 

break. Empty tags do not have to be wrapped around copy and do not require a 

closing. 

v) Entering paragraph text on your web page:-  

Linking to another page on the Internet is pretty much a standard part of designing a 

website, so much so that it is included as a basic skill in any course on creating a 



 
website. When someone clicks on a link on your site, the browser normally takes that 

person to the top of the new document. 

<p> 

This is the text of the top paragraph. Normally, when a web browser opens a new 

page, it will take the user to the top of the page. 

</p> 

vi) The <BR>  tag:-The <br> tag inserts a single line break. The <br> tag is an empty tag 

which means that it has no end tag. 

vii) The comment tag:- 

<!--This is a comment. Comments are not displayed in the browser--> 

 

<p>This is a paragraph.</p> 

viii) Working with HTML text:-  

How to Specify Text Size 

How to Specify Text Color 

How to Specify Text Fonts 

How to Format Text 

How to Preformat Text 

How to Control Line Breaks 

How to Use Special Text Characters 



 

The real value of the World Wide Web is information. If the Web is nothing else, it's an amazing 

and diverse source of information. A true reflection of the people who feed the information into 

the vast machine, some of the available information is good, and some of it is bad. Some is 

profoundly important, and some is ridiculously useless. And of course, it all depends on the 

perspectives of the Web author and the Web surfer. What I find interesting might bore you to 

tears. What you find entertaining, I might find offensive. 

You can find pictures on the Web to show you information. There are movies on the Web so that 

you can watch information move. And you can seek out audio on the Web so that you can hear 

information. But by far the most common form information takes is the written word. There are 

millions of words on the Web. They are constantly being added, continually being revised. These 

words are written in virtually every language spoken by the human tongue. 

ix) Emphasing text implicitly and explicitly 

 

Implicit tags are those that allow the browser to choose, within limitations, how the 

marked-up text will be displayed. Header tags are actually an example of an implicit 

tag, since the HTML designer has no control over how much bigger or smaller a 

header tag will be. Although most browsers will render header tags in somewhat 

similar ways, others (for instance, nongraphical browsers) have to come up with 

another system for emphasis, such as underlining or highlighting the text.  

Because HTML was originally created with the overriding mission of being displayed 

on nearly any computer system, implicit tags for emphasis were a necessity. HTML 

allows the designer to decide what text will be emphasized. But only explicit tags tell 

the Web browser how to render that text.  

Explicit tags are also often called physical tags, since they very specifically tell the Web browser 

how you want the text to physically appear. The browser is given no choice in the matter.  

Implicit styles are often called logical styles, since they allow the browser some freedom in how 

it will display the text. These tags, like the header tags, are generally relative to one another, 

depending on the browser being used to view them. 

x) The <block quote> element 

<blockquote cite="http://www.worldwildlife.org/who/index.html"> 

For 50 years, WWF has been protecting the future of nature. The world’s leading 

conservation organization, WWF works in 100 countries and is supported by 1.2 million 

members in the United States and close to 5 million globally. 

</blockquote> 

xi) Using<Pre> tag 



 
                 <pre> 

 

Text in a pre element is displayed in a fixed-width font, and it preserves both      spaces and 

line breaks 

</pre> 

Xii) The <Dir> tag 

<dir> 

  <li>html</li> 

  <li>xhtml</li> 

  <li>css</li> 

</dir> 

xii) The <Font> tag 

<font size="3" color="red">This is some text!</font> 

<font size="2" color="blue">This is some text!</font> 

<font face="verdana" color="green">This is some text!</font>  

xiii) The <Base font> tag 

<basefont face="cursive,serif" color="#ff9900" size="4"/> 

<p>The HTML basefont tag is now deprecated. You should use CSS font to set font 

properties instead.</p> 

xiv) Using lists in web documents 

The problem of extracting structured data (i.e. lists, record sets, tables, etc.) from the Web 

has been traditionally approached by taking into account either the underlying markup 

structure of a Web page or the visual structure of the Web page. However, empirical 

results show that considering the HTML structure and visual cues of a Web page 

independently do not generalize well. We propose a new hybrid method to extract general 



 
lists from the Web. It employs both general assumptions on the visual rendering of lists, 

and the structural representation of items contained in them. We show that our method 

significantly outperforms existing methods across a varied Web corpus. 

xv) Nested ordered 

<ol> 

  <li>One</li> 

  <li>Two</li> 

  <ol> 

    <li>Inner One</li> 

    <li>inner Two</li> 

  </ol> 

  <li>Three</li></ol> 

xvii) Unordered lists 

An unordered list typically is a bulleted list of items. HTML 3.0 gives you the ability to 

customise the bullets, to do without bullets and to wrap list items horizontally or 

vertically for multicolumn lists. 

<UL> 

      <LH>Table Fruit</LH> 

      <LI>apples 

      <LI>oranges 

      <LI>bananas 

    </UL> 

xviii) Menu lists 

This is a quick CSS tutorial to show you how to create a menu list using either the CSS 

border style or a background image. The trick is to apply a bottom border to the <li> 

element, then use the absolute position property to shift the nested elements down to 

cover the border. It is very flexible — you can easily change the layout by altering the 



 
border or background image. It even works when the browser's font size is being scaled 

(increased or decreased). 

xix) Directory list:- Theoretically, the recommendation has been and still is that DIR 

element be rendered as a multicolumn directory list. 

<DIR> 

<LI>one 

<LI>two 

<LI>three 

</DIR> 

xxi) Definition list:- A definition list is a list of terms and corresponding definitions. 

Definition lists are typically formatted with the term on the left with the definition 

following on the right or on the next line. The definition text is typically indented 

with respect to the term.  

<DL> 

<LH>List Header</LH> 

<DT>Term 1<dd>This is the definition of the first term. 

<DT>Term 2<dd>This is the definition of the second term. 

</DL> 

D) Graphics for web pages 

i) <img> tag 

<img src="smiley.gif" alt="Smiley face" height="42" width="42"> 

ii) Scaling down an image 

Many/most image editing software tools provide the ability to resize your image. The 

most common resizing is to scale down the image. When resizing an image this, you will 

want to maintain as much clarity as possible. This usually means that you do not want the 

image scaled merely by having pixels thrown out or duplicated identically. Rather, you 

probably want the software to do some level of interpolation to smooth the image. 



 
iii) Adding entire images to web pages 

By now you know enough to write a very nice, text-based home page, but it is the ability 

of the Web to provide pictures, technically called images, graphics, or sometimes icons, 

that has made it so popular. In this Primer, you'll learn how place an image on your page 

and also how to turn an image into a link to another page. 

iv) Working with links 

The tags used to produce links are the <a> and </a>.  

The <a> tells where the link should start and the </a> indicates where the link ends. 

Everything between these two will work as a link.The target of the link is added to the 

<a> tag using  the href="http://www.whateverpage.com" setting. 

v) Relative and absolute link 

An absolute link defines the location of the document in total including the protocol 

required to get the document, the server to get it from, the directory it is located in and 

then the name of the document itself. An absolute link will look like this: 

<a href="http://www.navegabem.com/index.html">Home</a> 

A relative link on the other hand takes advantage of the fact that the server knows where 

the current document is. Thus, if we want to link to another document in the same 

directory, we don't need to write out the full URL. All we need to use is the name of the 

file. For example, if we are looking at the link in the previous example, and we want to 

link to a file called index.html in the same directory, we need not write out the entire 

URL. A relative link will look like this: 

<a href="index.html">Home</a> 



 
vi) Link tag:-A hyperlink (or link) is a word, group of words, or image that you 

can click on to jump to another document. When you move the cursor over a 

link in a Web page, the arrow will turn into a little hand. The most important 

attribute of the <a> element is the href attribute, which indicates the link’s 

destination. 

<a href="url">Link text</a> 

E) Tables ,frames and forms 

i) Creating borderless tables 

<TABLE WIDTH="550" CELLPADDING=0 CELLSPACING=0  

  BORDER=0 BGCOLOR="#000000"> 

<TR> 

 <TD> 

 <CENTER> 

 <FONT SIZE="3" COLOR="#EEEEEE" FACE="ARIAL"> 

  <B>THIS TABLE IS OUR TITLE AREA</B></FONT> 

 </CENTER> 

 </TD> 

 </TR> 

</TABLE> 

 

<TABLE CELLPADDING=0 BORDER=0 CELLSPACING="0"  

    WIDTH="550" BGCOLOR="#66FFCC"> 

 <TR> 

   <TD> 

   <FONT FACE="ARIAL"> 

   &nbsp;<BR> 

   In this example, the black region above is one table, and  

   this table contains this text. By setting CELLPADDING, BORDER, 

  and CELLSPACING all to 0 (ZERO), I can get a clean result! 

   <BR> 

   &nbsp; 

   <BR> 

   </FONT> 

   </TD> 

 </TR> 



 
</TABLE> 

ii) Frames 

<frameset cols="25%,*,25%"> 

  <frame src="frame_a.htm"> 

  <frame src="frame_b.htm"> 

  <frame src="frame_c.htm"> 

</frameset> 

iii) Forms 

An HTML form is a section of a document containing normal content, markup, special 

elements called controls (checkboxes, radio buttons, menus, etc.), and labels on those 

controls. Users generally "complete" a form by modifying its controls (entering text, 

selecting menu items, etc.), before submitting the form to an agent for processing. 

<FORM action="http://somesite.com/prog/adduser" method="post"> 

    <P> 

    <LABEL for="firstname">First name: </LABEL> 

              <INPUT type="text" id="firstname"><BR> 

    <LABEL for="lastname">Last name: </LABEL> 

              <INPUT type="text" id="lastname"><BR> 

    <LABEL for="email">email: </LABEL> 

              <INPUT type="text" id="email"><BR> 

    <INPUT type="radio" name="sex" value="Male"> Male<BR> 

    <INPUT type="radio" name="sex" value="Female"> Female<BR> 

    <INPUT type="submit" value="Send"> <INPUT type="reset"> 

    </P> 

 </FORM> 

 

 

 

 



 
UNIT-II (Java Script) 

i) Introduction to client-side scripting  

Client-side scripting generally refers to the class of computer programs on the 

web that are executed client-side, by the user's web browser, instead of server-

side (on the web server).
[1]

 This type of computer programming is an important 

part of the Dynamic HTML (DHTML) concept, enabling web pages to be 

scripted; that is, to have different and changing content depending on user input, 

environmental conditions (such as the time of day), or other variables. 

Client-side scripts are often embedded within an HTML or XHTML document 

(hence known as an "embedded script"), but they may also be contained in a 

separate file, to which the document (or documents) that use it make reference 

(hence known as an "external script"). Upon request, the necessary files are sent 

to the user's computer by the web server (or servers) on which they reside. The 

user's web browser executes the script, then displays the document, including any 

visible output from the script. Client-side scripts may also contain instructions for 

the browser to follow in response to certain user actions, (e.g., clicking a button). 

Often, these instructions can be followed without further communication with the 

server. 

ii) Java script 

JavaScript (JS) is an interpreted computer programming language.
[5]

 It was 

originally implemented as part of web browsers so that client-side scripts could 

interact with the user, control the browser, communicate asynchronously, and 

alter the document content that was displayed.
[5]

 More recently, however, it has 

become common in both game development and the creation of desktop 

applications. 

JavaScript is a prototype-based scripting language that is dynamic, is type safe, 

and has first-class functions. Its syntax was influenced by the language C. 

JavaScript copies many names and naming conventions from Java, but the two 

languages are otherwise unrelated and have very different semantics. The key 

design principles within JavaScript are taken from the Self and Scheme 

programming languages.
[6]

 It is a multi-paradigm language, supporting object-

oriented,
[7]

 imperative, and functional
[1][8]

 programming styles. 

JavaScript's use in applications outside of web pages—for example, in PDF 

documents, site-specific browsers, and desktop widgets—is also significant. 

Newer and faster JavaScript VMs and frameworks built upon them (notably 



 
Node.js) have also increased the popularity of JavaScript for server-side web 

applications. 

iii) JavaScript & data 

JavaScript has dynamic types. This means that the same variable can be used as 

different types: 

Example 

var x;               // Now x is undefined 

var x = 5;           // Now x is a Numbervar x = "John";      // Now x is a String 

                        JavaScript Strings 

A string is a variable which stores a series of characters like "John Doe". 

A string can be any text inside quotes. You can use single or double quotes: 

Example 

var carname="Volvo XC60"; 

var carname='Volvo XC60'; 

You can use quotes inside a string, as long as they don't match the quotes 

surrounding the string: 

Example 

var answer="It's alright"; 

var answer="He is called 'Johnny'"; 

var answer='He is called "Johnny"'; 

iv) Types of scripts 

A client-side script is a program that may accompany an HTML document or be embedded 

directly in it. The program executes on the client's machine when the document loads, or at some 

other time such as when a link is activated. HTML's support for scripts is independent of the 

scripting language.  

Scripts offer authors a means to extend HTML documents in highly active and interactive ways. 

For example: 

• Scripts may be evaluated as a document loads to modify the contents of the document 

dynamically.  



 
• Scripts may accompany a form to process input as it is entered. Designers may 

dynamically fill out parts of a form based on the values of other fields. They may also 

ensure that input data conforms to predetermined ranges of values, that fields are 

mutually consistent, etc.  

• Scripts may be triggered by events that affect the document, such as loading, unloading, 

element focus, mouse movement, etc.  

• Scripts may be linked to form controls (e.g., buttons) to produce graphical user interface 

elements.  

There are two types of scripts authors may attach to an HTML document: 

• Those that are executed one time when the document is loaded by the user agent. Scripts 

that appear within a SCRIPT element are executed when the document is loaded. For user 

agents that cannot or will not handle scripts, authors may include alternate content via the 

NOSCRIPT element.  

• Those that are executed every time a specific event occurs. These scripts may be assigned 

to a number of elements via the intrinsic event attributes.  

v) Conversion of functions 

Javascript (ECMAScript) is a loosely typed language. That does not mean that 

it has no data types just that the value of a variable or a Javascript object 

property does not need to have a particular type of value assigned to it, or that it 

should always hold the same type of value. Javascript also freely type-converts 

values into a type suitable for (or required by) the context of their use.  

Javascript being loosely typed and willing to type-convert still does not save 

the programmer from needing to think about the actual type of values that they 

are dealing with. A very common error in browser scripting, for example, is to 

read the value property of a form control into which the user is expected to type 

a number and then add that value to another number. Because the value 

properties of form controls are strings (even if the character sequence they 

contain represents a number) the attempt to add that string to a value, even if 

that value happens to be a number, results in the second value being type-

converted into a string and concatenated to the end of the first string value from 

the from control.  

That problem arises from the dual nature of the + operator used for both 

numeric addition and string concatenation. With which the nature of the 

operation performed is determined by the context, where only if both operands 

are numbers to start with will the + operator perform addition. Otherwise it 

converts all of its operands to strings and does concatenation.  

The following discussion is illustrated with Javascript generated tables of 

values resulting from the conversion operations. The headers of those tables 

display the values as represented in the Javascript source code used rather than 

their internal representation. So, for example 123e-2 as a number was the 



 
character sequence typed into the source code, the interpreter reads that and 

generates the number value 1.23 from it for internal use. The various values 

used for the tests have been chosen to illustrate aspects of type converting, 

those aspects may not apply to all of the tables presented. However, all of the 

test values are included in all of the tables (except where no type converting 

occurs) for full comparison. The bodies of the tables list the results of the 

various type conversion operations.  

vi) Arrays:- An array is a special variable, which can hold more than one value at a 

time. 

var mycars = new Array(); 

mycars[0] = "Saab"; 

mycars[1] = "Volvo"; 

mycars[2] = "BMW"; 

vii) Operations 

The assignment operator = is used to assign values to JavaScript variables. 

Arithmetic operators are used to perform arithmetic between variables and/or values. 

Assignment operators are used to assign values to JavaScript variables. 

The + operator can also be used to add string variables or text values together. 

viii) Statements  

JavaScript statements are "commands" to the browser. 

The purpose of the statements is to tell the browser what to do. 

This JavaScript statement tells the browser to write "Hello Dolly" inside an 

HTML element with id="demo": 

document.getElementById("demo").innerHTML="Hello Dolly"; 



 
ix) Functions :- A function is a block of code that will be executed when "someone" 

calls it. 

<html> 

<head> 

<script> 

function myFunction() 

{ 

alert("Hello World!"); 

} 

</script> 

</head> 

 

<body> 

<button onclick="myFunction()">Try it</button> 

</body> 

</html> 

x) Objects :- In JavaScript, an object is data, with properties and methods. 

var txt = "Hello"; 

xi) Events:- Events are signals generated when specific actions occur. JavaScript is 

aware of these signals, and scripts can be built to react to these events. Examples 

of events include when a user clicks on a hypertext link, changes data in a form 

entry field, or when a page finishes loading 

xii) Window events: HTML 4 added the ability to let events trigger actions in a 

browser, like starting a JavaScript when a user clicks on an element. To learn 



 
more about programming events. Below are the global event attributes that can be 

added to HTML elements to define event actions. 

xiii) Image events:- The Image object represents an embedded image.For each <img> 

tag in an HTML document, an Image object is created.Notice that images are not 

technically inserted into an HTML page, images are linked to HTML pages. The 

<img> tag creates a holding space for the referenced image. 

xiv) The window object:- The window object, which is a top-level object in Client 

Side JavaScript, represents a window or a frame (within a frameset). Since 

window object is a top-level object, it contains other objects like 'document', 

'history' etc. within it. For example, window.document.frames[i], where i is 

1,2,3....., refers to the index of the frame residing in the current window. For a 

top-level window, the parent and top properties refer to the window itself. For 

frame, the top refers to the topmost browser window, and parent refers to the 

parent window of the current window. 

If a frame has name and src attribute you can refer to that frame from a sibling 

frame by using parent.frameName or parent.frames[i], where i is 1,2,3....... 

A window object is opened with window.open() and closed with window.close(), 

if the window does not refer to a frame.  

xv) Opening & closing window:- You can open multiple windows of the same type, 

which may be useful when you want to individually display and alter the contents 

of several regions in a particular editor type. However, in order to streamline 

window management and avoid accidentally opening multiple windows of the 

same type, the following behavior is observed when opening windows: If the 

requested window type is in the background of the screenset, it is brought to the 

foreground. If the requested window type is already in the foreground, another 



 
window of the requested type is opened. If the requested window is not open in 

the current screenset, it is opened. 

xvi) Communicating with the user:- As web sites and applications become richer 

and more complex, the user experience (UX) becomes critical to their success. 

This indispensible and full-color book provides practical guidance on this 

growing field and shares valuable UX advice that you can put into practice 

immediately on your own projects. The authors examine why UX is gaining so 

much interest from web designers, graduates, and career changers and looks at the 

new UX tools and ideas that can help you do your job better. In addition, you'll 

benefit from the unique insight the authors provide from their experiences of 

working with some of the world's best-known companies, learning how to take 

ideas from business requirements, user research, and documentation to create and 

develop your UX vision. 

xvii) Displaying information on the status bar:- A status bar, similar to a status 

line, is an information area typically found at the bottom of windows in a 

graphical user interface.
[1]

 A status bar is sometimes divided into sections, each of 

which shows different information. Its job is primarily to display information 

about the current state of its window, although some status bars have extra 

functionality. For example, many web browsers have clickable sections that pop 

up a display of security or privacy information. A status bar can also be text-

based, primarily in console-based applications, in which case it is usually the last 

row in an 80x25 text mode configuration, leaving the top 24 rows for application 

data. Usually the status bar (called a status line in this context) displays the 

current state of the application, as well as helpful keyboard shortcuts. One 

example is the 'vi' text editor of UNIX (from the 1970s) or newer Linux 

systems.
[2] 

Status lines have been used for more than 30 years
[2]

 to display 

advisory messages in a predefined area, rather than as pop-up messages in center 

screen which can block the view of related information. Sometimes, a video game 

places the player's vital information (such as hit points, lives, and score) on a 



 
similar strip across the top or bottom of the screen; this is also referred to as a 

status bar. 

xviii) Working with time sets:- 

The Javascript setTimeout() function allows code to be executed a set time after some trigger, 

such as when the page has loaded or a button is pressed. This post looks at how to trigger events 

after a set time with Javascript and alsp how to clear the timeout. 

<script language="Javascript"> 

 

function timeout_trigger() { 

    window.alert('Hello!');    

} 

 

function timeout_init() { 

    setTimeout('timeout_trigger()', 2000); 

} 

 

</script> 

<input type="button" value="click me" onclick="timeout_init()" /> 

xix) The frame object:-  For security reasons, resizing is disabled for frame objects 

that display content hosted on a domain different from the domain hosting the 

parent document. If you trust the content you are loading into an frame object, 

you can enable resizing by specifying values for the minWidth and maxWidth 

attributes of the frame element in the source of the parent document. You must 

specify values for both attributes to enable resizing. 

Microsoft Internet Explorer 5.5 supports transparent content for a frame. The following 

conditions must be met to define transparent content for a frame.  



 
The allowTransparency attribute, used with the frame element, must be set to 

VARIANT_TRUE. 

In the frame content source document, the backgroundColor or bgColor attribute of the 

body element must be set to transparent. 

<frame frameborder=0 scrolling="no" src="sample.htm"> 

xx) The document object:- When an HTML document is loaded into a web browser, 

it becomes a document object. The document object is the root node of the 

HTML document and the "owner" of all other nodes: 

(element nodes, text nodes, attribute nodes, and comment nodes). 

The document object provides properties and methods to access all node objects, 

from within JavaScript. 

xxi) The form object:-Forms on the page are represented in JavaScript via the form 

object, and can be accessed in one of the 3 standard ways below: 

document.yourformname //where yourformname is the name of your form. 

document.form.yourformname 

document.forms["yourformname"] 

 

xxii) Math object:-The Math object allows you to perform mathematical tasks.The 

Math object includes several mathematical constants and methods. 

Syntax for using properties/methods of Math: 

var x=Math.PI; 

var y=Math.sqrt(16); 

 

Introduction to Active Server Pages 



 
i) Introduction & what is ASP? 

Active Server Pages (ASP), also known as Classic ASP or ASP Classic, was Microsoft's 

first server-side script engine for dynamically generated web pages. Initially released as 

an add-on to Internet Information Services (IIS) via the Windows NT 4.0 Option Pack 

(ca. 1996), it was subsequently included as a free component of Windows Server (since 

the initial release of Windows 2000 Server). ASP.NET, first released in January 2002, 

has superseded ASP. 

ASP 2.0 provided six built-in objects: Application, ASPError, Request, Response, Server, 

and Session. Session, for example, represents a session that maintains the state of 

variables from page to page.
[1]

 The Active Scripting engine's support of the Component 

Object Model (COM) enables ASP websites to access functionality in compiled libraries 

such as DLLs. 

ASP 3.0 does not differ greatly from ASP 2.0 but it does offer some additional 

enhancements such as: Server.Transfer method, Server.Execute method, and an enhanced 

ASPError object. ASP 3.0 also enabled buffering by default and optimized the engine for 

better performance. 

The use of ASP pages with Internet Information Services (IIS) is currently supported on 

all supported versions of IIS. The use of ASP pages will be supported on Windows 8 for 

a minimum of 10 years from the Windows 8 release date 

ii) Applications of ASP:- ASP, a third-party entity that manages and distributes 

software-based services and solutions to customers across a wide area network 

from a central data center.In essence, ASPs are a way for companies to 

outsource some or almost all aspects of their information technology needs. 

They may be commercial ventures that cater to customers, or not-for-profit or 

government organizations, providing service and support to end users. 

                                   According to ASPnews.com, ASPs are broken down into five 

subcategories: 

Enterprise ASPs -- deliver high-end business applications.  

Local/Regional ASPs -- supply wide variety of application services for smaller 

businesses in a local area.  



 
Specialist ASPs -- provide applications for a specific need, such as Web site services or 

human resources.  

Vertical Market ASPs -- provide support to a specific industry, such as healthcare.  

Volume Business ASPs -- supply general small/medium-sized businesses with 

prepackaged application services in volume. 

iii) Elements of ASP 

I am writing some pages in ASP.NET VB. Based on some database results I need certain 

pieces of information to display, basically if a column is not null then write out 

<p>database value</p>. So far, all the databse connection is called in my .aspx.vb file. 

Rather than have an asp:label (which creates a <span> not a <p> anyway) I was hoping I 

could keep all my HTML markup front end, so have some ASP Classic code that looks 

like: 

<% if results.item("name").value <> "" then 

response.write("<p>" + results.item("name").value + "</p>" 

end if%> 

The problem with this of course is results is not accessible from the front end. 

Possibly this is the wrong approach, maybe someone can suggest an alternative if there 

are better ways. However, I don't like relying solely on Labels, Panels and other built in 

elements which create spans, divs, etc respectively. 

This might sound silly, but there is a reason for this. I need to get some database content 

into some javascript. Currently I have to load the content into a span (label) which is 

hidden by css, and then javascript gets the value of this span. I think this is a very poor 

way of doing things so would prefer to be able to write out exactly when I want it without 

any unexpected markups. 

iv) Functions of ASP:- You can write functions in ASP similar to the way you 

write them in Visual BASIC. It is good programming practice to use functions 

to modularize your code and to better provide reuse. To declare a subroutine 

(a function that returns no value), you simply type:  

<%@ LANGUAGE="VBSCRIPT" %> 

<% 



 
    sub SubroutineName( Parameters to Pass In ) 

        'Code for Sub... 

    end sub 

%>  

A function differs from a subroutine in the fact that it returns data. To declare a function, 

the syntax is similar:  

<%@ LANGUAGE="VBSCRIPT" %> 

<% 

    function FunctionName( Parameters to Pass In ) 

        'Code for Function... 

    end function 

%>  

Let's look at the code for a function that takes an integer value and returns the square of 

that value. Also included is code to call the function.  

v) Operators:-  

Operators in ASP fall into four categories Math, Comparisons, the somewhat more 

advanced Logic operators, and Leftovers(those that don't fit well into any category).  

• ASP Arithmetic Operators 

The mathematical operators in ASP are similar to many other programming languages. 

However, ASP does not support shortcut operators like ++, --, +=, etc.  

Operator English Example Result 

+ Addition myNum = 3 + 4 myNum = 7 

- Subtraction myNum = 4 - 1 myNum = 3 

* Multiplication myNum = 3 * 2 myNum = 6 

/ Division myNum = 9 / 3 myNum = 3 

^ Exponential myNum = 2 ^ 4 myNum = 16 

Mod Modulus myNum = 23 Mod 10 myNum = 3 



 

- Negation myNum = -10 myNum = -10 

\ Integer Division myNum = 9 \ 3 myNum = 3 

• Comparison Operators 

Comparison operators are used when you want to compare two values to make a 

decision.Comparison operators are most commonly used in conjunction with "If...Then" 

and "While something is true do this..." statements, otherwise known as conditional 

statements. The items that are most often compared are numbers. The result of a 

comparison operator is either TRUE or FALSE.  

Operator English Example Result 

= Equal To 4 = 3 False 

< Less Than 4 < 3 False 

> Greater Than 4 > 3 True 

<= Less Than Or Equal To 4 <= 3 False 

>= Greater Than Or Equal To 4 >= 3 True 

<> Not Equal To 4 <>3 True 

• Logical Operators 

The above comparison operators result in a truth value of TRUE or FALSE. A logical 

operator is used for complex statements that must make decisions based on one or more 

of these truth values.  

Operator English Example Result 

And Both Must be TRUE True and False False 

Or One Must be TRUE True or False True 

Not Flips Truth Value Not True False 

• String Operators 

The only string operator is the string concatenation operator "&" that takes two strings 

and slams them together to form a new string. An example would be string1 = "Tim" and 

string2 = " is a Hero". The following code would combine these two strings into one: 

string3 = string1 & string2  

Operator English Example Result 

& String Concatenation string4 = "Bob" & " runs" string4 = "Bob runs" 

vii) Event driven programming:-In computer programming, event-driven 

programming (EDP) or event-based programming is a programming 



 
paradigm in which the flow of the program is determined by events—e.g., 

sensor outputs or user actions (mouse clicks, key presses) or messages from 

other programs or threads. Event-driven programming can also be defined as 

an application architecture technique in which the application has a main loop 

which is clearly divided down to two sections: 

• the first is event selection (or event detection) 

• the second is event handling. 

In embedded systems the same may be achieved using interrupts instead of a 

constantly running main loop; in that case the former portion of the architecture resides 

completely in computer hardware. 

Event-driven programs can be written in any language, although the task is easier 

in languages that provide high-level abstractions, such as closures. 

viii) Query strings:- In the World Wide Web, a query string is the part of a 

uniform resource locator (URL) that contains data to be passed to web 

applications such as CGI programs. When a web page is requested via the 

Hypertext Transfer Protocol, the server locates a file in its file system based 

on the requested URL. This file may be a regular file or a program. In the 

second case, the server may (depending on its configuration) run the program, 

sending its output as the requested page. The query string is a part of the URL 

which is passed to the program. Its use permits data to be passed from the 

HTTP client (often a web browser) to the program which generates the web 

page. 

ix) ASP objects:- ASP built-in objects) that are available to ASP pages. Using 

ASP built-in objects, you can access to information regarding the Web server, 



 
the client who is accessing a Web page, the Web application that contains the 

Web page, and the fields in the HTTP request and response streams. The ASP 

built-in objects are organized by the type of information they contain.The 

information in ASP built-in objects can also be obtained in a COM component 

or an ISAPI application. The following table lists the technologies from which 

ASP built-in objects can be accessed and how to access them. 

x) Database management through ASP:-Administration modules that I think 

web developers will find super useful.  This preview adds several new 

features to the IIS7 Admin Tool: 

• Database Manager: Built-in SQL Server database management, including the ability to 

create, delete, and edit tables and indexes, create/edit SPROCs and execute custom 

queries.  Because it is integrated in the IIS administration tool it all works over 

HTTP/SSL - which means you can use the module to remotely manage your hosted 

applications (even with low-cost shared hosting accounts), without having to expose your 

database directly on the Internet. 

• Log Reports: Built-in report visualization with charting support for log files data.  Full 

range selection and custom chart creation is supported, as well as the ability to print or 

save reports.  Like the database manager you can use this module remotely over 

HTTP/SSL - which means it works in remote shared hosting scenarios. 

• Configuration Editor: This is a power module that provides complete control over 

editing all web.config settings within the admin tool.  You can configure it to track the 

changes you make using the UI and have it auto-generate configuration change scripts 

that you can then save and tweak to re-run later in an automated way. 

• Request Filtering UI: This admin module provides more control over the new request 

filtering feature in IIS7.  Check out Carlos' blog post for details on how to use it. 

• .NET Authorization: This admin module provides a custom authorization rules editor 

which allows you to more easily manage the ASP.NET <authorization> configuration 

section. 

• FastCGI UI: This admin module provides more support for editing all the new 

<fastCGI> settings (for when you use FastCGI modules with IIS7 like PHP). 



 
UNIT-III 

Introduction to Dreamweaver 

i) Introduction & what is dreamweaver?:- Dreamweaver is designed to or is 

even capable of completely removing the agency of HTML and CSS coding 

from web design. This is like saying that a nail-gun can completely replace a 

hammer. A nail-gun will nail the boards together, but it is an imprecise tool, 

and there is a certain amount of danger while using it. If you can’t 

occasionally fall back on the hammer for more detail-oriented work, then 

there’s a definite limit to what you can build. A skilled carpenter knows how 

to use the hammer and occasionally does so when the nail-gun just isn’t doing 

what is intended. Dreamweaver, like the nail-gun, is designed to make your 

life easier. You may never learn HTML or CSS, but without knowing them, 

you are limited to Dreamweaver’s way of doing things. This is not altogether 

a bad thing: it is simply a slightly narrow perspective on a large field. 

ii) Interfaces:- 

Learn how to overcome the difficulties and issues encountered in applying operations research 

and management science to real-life situations. Interfaces, a bimonthly journal of INFORMS, is 

dedicated to improving the practical application of OR/MS to decisions and policies in today's 

organizations and industries. Each article provides details of the completed application, along 

with the results and impact on the organization. Interfaces is essential reading for analysts, 

engineers, project managers, consultants, students, researchers, and educators! 

iii) The property inspector:- 



 
You can use the text Property inspector to apply HTML formatting or Cascading Style Sheet 

(CSS) formatting. When you apply HTML formatting, Dreamweaver adds properties to the 

HTML code in the body of your page. When you apply CSS formatting, Dreamweaver writes 

properties to the head of the document or to a separate style sheet. 

iv) Setting properties for web page:-  

You can edit the properties for a Web site using Web Site Designer's Detail view. This allows 

you to edit and manage the file data and meta information associated with each Web page in a 

Web site. 

To edit the Web page properties, do the following:  

1. Double-click Web Site Navigation in your Web project to open the Web site 

navigation in Site Designer. 

2. Switch to the Detail view. 

3. Right-click the line that you want to edit. Select the field that you want to edit from the 

pop-up menu. Make the changes. 

4. You can also edit Web site information by right-clicking on any of the fields and 

selecting one of the following options:  

1. Sort to reorder the way the Web pages are organized in the Detail view. 

2. Renumber IDs to change the ID number. 

3. Web Site properties to specify and edit the Web Site template, the Author and 

the Description of the Web site. 

5. Press CTRL+S to save your changes. 

v) Text formatting:- Since the invention of MacWrite, the first WYSIWYG 

word processor, in which the typist codes the formatting visually rather than 

by inserting textual markup, word processors have tended to save to binary 

files. Opening such files with a text editor reveals the text embellished with 

various binary characters, either around the formatted areas (e.g. in 

WordPerfect) or separately, at the beginning or end of the file (e.g. in 

Microsoft Word). 

  Formatted text documents in binary files have, however, the disadvantages of formatting      

scope and secrecy. Whereas the extent of formatting is accurately marked in markup 



 
languages, WYSIWYG formatting is based on memory, that is, keeping for example your 

pressing of the boldface button until cancelled. This can lead to formatting mistakes and 

maintenance troubles. As for secrecy, formatted text document file formats tend to be 

proprietary and undocumented, leading to difficulty in coding compatibility by third parties, 

and also to unnecessary upgrades because of version changes. 

WordStar was a popular word processor that did not use binary files with hidden 

characters. 

OpenOffice.org Writer saves files in an XML format. However, the resultant file is a 

binary since it is compressed (a tarball equivalent). 

PDF is another formatted text file format that is usually binary (using compression for the 

text, and storing graphics and fonts in binary). It is generally an end-user format, written 

from an application such as Microsoft Word or OpenOffice.org Writer, and not editable 

by the user once done. 

Working with links & multimedia 

i) Adding hyperlink in webpages 

Creating hyperlinks from text allows you to navigate your viewers through your web 

pages as well as send them to other web pages. To create a link from text to another 

web page, use the following steps: 

Step 1: Select the text (double click in the text box and then highlight the specific text) 

and then click the ‘create hyperlink’  icon on the toolbar. 

Step 2: In the dialog box, choose to link to a page on your website, an external 

website, or to a file uploaded to your account. 

ii) Relative and absolute path:- Absolute paths are called that because 

they refer to the very specific location, including the domain name. 

The absolute path to a web element is also often referred to as the 

URL. For example, the absolute path to this web page is:  

http://webdesign.about.com/od/ beginningtutorials/a/aa040502a.htm  

You typically use the absolute path with the domain to point to Web elements that are on another domain 

 than your own. 



 
Relative paths change depending upon the page the links are on. There are several rules to 

creating a link using the relative path:  

links in the same directory as the current page have no path information listed  

filename 

iii) Working with bookmarks 

A bookmark in Adobe Acrobat 9 is simply a link represented by text in the Bookmarks 

panel. Bookmarks that are created automatically by many authoring programs are 

generally linked to headings in the text or to figure captions, but you can also add your 

own bookmarks in Acrobat to create a custom outline of a document or to open other 

documents. 

Additionally, you can use electronic bookmarks as you would paper bookmarks—to 

mark a place in a document that you want to highlight, or to which you want to return 

later 

iv) Mail to link 

Spaces between words should be replaced by %20 to ensure that the browser will display the text 

properly. 

<html> 

<body><p> 

This is an email link: 

<a href="mailto:someone@example.com?Subject=Hello%20again" target="_top"> 

Send Mail</a> 

</p><p> 

<b>Note:</b> Spaces between words should be replaced by %20 to ensure that the browser will 

display the text properly. 



 
</p></body> 

</html> 

v) Working with images 

it easy to add great artwork to your iOS applications. This article looks at how to use 

Xamarin.iOS to take advantage of iOS image support. iOS defines two basic categories where 

icons and images are used, application support images and images applied to controls. In both 

cases, iOS has built in support for handling various device resolutions. More specifically, here 

are the three iOS image-handling topics we’re going to cover in this article:  

• Application Support Images – These include image locations defined by the system such 

as application icons, loading screens, settings, and spotlight search icons.  

• Resolution Independent Images – iOS includes built-in support for working with images 

across different device resolutions  

• Images in Code – The UIImage class includes methods for loading images that can be 

applied to controls.  

vi) Aligning image with text 

The align attribute specifies the alignment of an image according to the surrounding element. 

The <img> element is an inline element (it does not insert a new line on a page), meaning that 

text and other elements can wrap around it. Therefore, it can be useful to specify the alignment 

of the image according to surrounding elements. 

<p>This is some text. <img src="smiley.gif" alt="Smiley face" align="middle"> This is some 

text.</p> 

vii) Image mapping 

An Image map is a graphic image designed in a way that allows different areas of the main 

image to be click-able by users. These click-able areas then link to different destinations that 

usually relate to the part of the image the user has clicked on. Aside from being very useful in 

web development, image maps are also very useful for images and banners being used on social 

networking sites such as facebook, twitter and myspace.  



 
Image-Maps.com provides an easy to use online html image mapping tool. Unlike other image 

map tools our tool is completely web based and does not require any software to be downloaded. 

With our image mapping tool you can choose to map images found on the web or from your PC. 

To use an image from the web simply use the link that points to the image on the web. To choose 

an image from your pc, simply browse your computer from the appropriate image map tool and 

select the image you wish to use.  

There are 3 simple steps to creating an image map:  

• Load the image 

• Map out your links 

• Get the code! 

viii) Creating rollover 

In Dreamweaver, Rollover images — as the name implies — are designed to react 

when someone rolls a cursor over an image. The effect can be as dramatic as a 

picture of a dog being replaced by a picture of a lion, or as subtle as the color of a 

word changing as one image replaces another. Either way, Dreamweaver includes a 

special dialog box for rollovers that makes creating a simple rollover effect one of 

the easiest behaviors to apply. 

To create a rollover image by using Dreamweaver's Insert Image Rollover dialog 

box, follow these steps:  

1. Click to place your cursor on the page where you want the rollover to appear. 

Rollover effects require at least two images: one for the initial state and one for the 

rollover state. Youcan use two different images or two similar ones, but they both 

should have the same dimensions. Otherwise, you get some strange scaling effects 

because both images must be displayed in exactly the same space on the page. 

2. Choose Insert --> Image Objects --> Rollover Image. 

The Insert Rollover Image dialog box appears. 

3. In the Image Name box, name your image. 

Tables and frames 

i) Create table 



 
Open Dreamweaver and create a new HTML file. From the Insert drop-down menu choose 

Table. Select the format of your table and click OK. Your table will be created in your page. 

Select the table and look at its Properties panel: Here you can modify your table by changing its 

attributes. Each cell of the table has its own Properties panel. Select the cell that you want to 

modify and the Properties panel will appear. Alternatively, you can go to Windows -> Properties 

Here you can select a style for the cell, background color, border size and color, text alignment, 

etc. 

ii) Add and remove rows and columns 

Add a row 

1. Insert the cursor in a cell in the row that you want to add a new row above or below. 

2. Choose Insert→Table Objects→Insert Row Above or Insert Row Below. 

Alternatively, press Ctrl+M (Windows) or Command+M (Mac). The new row appears. 

To add more rows to the bottom of the table, place the cursor in the last current row and 

press the Tab key. 

Delete a row 

1. Insert the cursor in a cell of the row you want to delete. 

2. Choose Modify→Table→Delete Row. 

Alternatively, press Ctrl+Shift+M (Windows) or Shift+Command+M (Mac). The row is 

deleted. 

 

Add a column 

1. Insert the cursor in a cell in the column that you want a new column added to the left 

or right of. 

2. Choose Insert→Table Objects→Insert Column to the Left or Insert Column to the 

Right. 

The new column appears. 

Delete a column 

1. Insert the cursor in a cell of the column you want to delete. 



 
2. Choose Modify→Table→Delete Column. 

Alternatively, press Ctrl+Shift+– (minus) (Windows) or Shift+Command+– (minus) (Mac). 

The column is deleted. 

iii) Nested tables 

Usually, an empty row/column in a table will collapse in a web 

browser.  I don't know if what was described provides a column to the 

left, so if there isn't one, add one.  A common way of control distances 

in tables is to use transparent gif images.  I have a 1x1px transparent 

gif image that I use for such purposes.  I just set the width/height 

values to resize it as needed in the page code. 

  

IF you haven't, you might try creating tables in the design mode.  It's 

fairly easy to use the tools/menues to megre cells and select cells for 

inserting a new table within another.  Most commands are avvailable 

via a right click. 

iv) Import table data 

Once you have created a spreadsheet or database, you can usually export or output it 

from its current application. For example, you can export an Excel file as a simple 

text file. Each cell in the spreadsheet or field in the database can be separated by a 

delimiter. This is often a tab or a comma. Depending on the type of information you 

are importing, you can choose the delimiter you think will work best. If you have text 

that contains commas, you may wish to choose tabs, so that extra separations or 

delimiters don't get placed in your table.  

1  In Dreamweaver, do one of the following: 

 Choose File > Import > Import Tabular Data. 

 Choose Insert > Tabular Data. 

2  In the Data File field, type the name of the file you want to import. 

3  From the Delimiter pop-up menu, choose the delimiter format that matches the format of the 

document you're importing. 

 If you choose Other, a field appears to the right of the pop-up menu. Enter the delimiter that 

was used to separate the table data.  

 Note: If you do not choose (or specify) the delimiter used when the file was saved, the file 

will not import properly, and your data will not be correctly formatted in a table. No error or 

warning message displays to alert that there is a problem. 

4  For Table Width, select one of the following options: 



 
 Select Fit to Data to create a table that adjusts to the longest text string in each table column. 

 Select Set to specify a table width as a percentage of the browser window or as a number of 

pixels. 

5  Specify the table formatting options: 

 In the Cell Padding field, specify the number of pixels between the cell content and the cell 

boundary (or wall). 

 In the Cell Spacing field, specify the number of pixels between each table cell. 

 From the Format Top Row pop-up menu, choose from four formatting options: no 

formatting, bold, italic, or bold italic. 

 In the Border field, specify the pixel width of the table border. Type 0 if you don't want a 

border. 

6  Click OK. 

v) Sorting data 

I need to set it up data to sort (ORDER BY) by the specific column/field (price, bedrooms, baths, 

etc.) when clicked on. For example, on ebay you can sort the results by price, ending time, etc.) 

I'm sure it's very simple, I'm just unfamiliar with it. I'm using Dreamweaver MX to do all of the 

database work - does anybody know of a plugin/extension that would handle this? 

vi) Export data from a table 

show you how to import and export tabular data that has been created in another 

application such as Excel or other like programs and saved in a delimited text format. 

Any data that has been saved in a delimited file format, such as tab, comma, colons, 

or other delimiter, can be imported into Dreamweaver and formatted as a table.  

You can also export a Dreamweaver table into a text file, with the contents of 

adjacent cells separated by a delimiter. You can use commas, colons, semicolons, or 

spaces as delimiters. When you export a table the entire table is exported into a 

delimited text file 

Because tables are best used for displaying tabular data, it's not surprising that Dreamweaver has 

an easy way to import such data. The data needs to be in the form of a delimited file such as a 

comma or tab delimited file. These are files that include the data separated by some character, 

such as a tab or a comma, or another delimeter.  

To import tabular data into a table, place the insertion point where you want the table to appear.  

Choose File > Import > Tabular Data or Choose Insert > Table Objects > Import Tabular Data. 



 
vii) Formatting tables:- You can change the appearance of tables by setting various table 

properties for the table and its cells or by applying a preset design to the table. Many 

of the table properties can be viewed and changed in Property Inspector with the table 

or cell selected.  

viii) Overview of frames:- Framesets are popular for many reasons. One of the main 

reasons one uses them is because it allows you to display banner and navigation areas 

that never leave the viewers sight while linking through the rest of the pages. This can 

be an asset if your pages are heavy and take a while to load. The viewer has 

something to look at and is less likely to leave. In this tutorial were going to take a 

straightforward approach to creating and managing Framesets in Dreamweaver. We 

will start from scratch and create one of the most common frameset layouts. The three 

frame Frameset. 

ix) Inserting a frameset:-When you look at a framed site, you are actually seeing 

multiple pages. You’ve seen the site in before, but not in frames. At first glance 

you might not notice that the site is framed. But once you start scrolling you’ll realize 

the difference. Notice the scrollbar in. See how it starts about halfway down the side 

of the page? That’s because there are actually three framed pages shown, and only the 

frame on the lower right has a scrollbar. 

x) Nested frameset:-To create a nested frameset—a frameset within the main 

frameset—that consists of two rows.  

To create a nested frameset:  

1 Click inside the right frame, then do one of the following: 

In the Object palette in the Frames panel, select the Insert Top 

Frame icon. 

xi) Attributes of frames:-  



 
Frames can be very labor intensive in when hand coding. Dreamweaver makes it easier to 

construct large Frame based sites. Even nested framesets are pretty easy to deal with. 

Remember that frames act like picture frames, in that they hold more than one web page for 

display simultaneously. Each frame will need a unique name so that it can be targeted by links 

later on. 

When building frames in Dreamweaver, you will need to make use of two palettes, the Properties 

Palette and the Frames Palette. Both can be found in the WINDOWS pull down menu. 

  

Tips for Building Pages for Frames 

1. Dreamweaver will allow you to visually build pages inside frames, but you will only be 

able to build the initial page inside of the frame. Other pages to be displayed in that frame 

will have to be built outside. Remember that you can change the viewable size of the 

Dreamweaver window by changing the size setting in the lower right corner. If you know 

how large your frame will be, you can set the page to display that size window. This will 

help you when designing pages meant to be displayed in frames. Custom sizes can be 

achieved by clicking "edit sizes" 

We are going to create a simple two-column frameset. 

1. Start with a blank page. Make sure you have both the Properties and Frames pallets are 

open. 

WINDOWS-> PROPERTIES and FRAMES  

2. Click INSERT FRAMES-> FRAME-> LEFT 

This will split the page into two vertical frames 

 

UNIT-IV (Introduction to flash) 

i) Introduction & Flash-6 new features 

By virtue of Flash Professional CS6 Update 12.0.2, Flash Professional extends 

support for AIR 3.4 and Flash Player 11.4. This update also allows Flash 



 
Professional to leverage features exposed by AIR 3.4 that enhance application 

development workflow for iOS devices. 

• Deploying AIR applications on iOS devices directly 

• Native iOS Simulator 

• High-resolution Retina Display Support for the new iPad 

Toolkit for CreateJS 1.2:- The Toolkit for CreateJS 1.2 release extends support for converting 

Buttons to HTML5. The update also includes fixes to several JSX related errors. Other issues 

such as omission of multiple empty keyframes have also been addressed in this update 

ii) Flash 6 vs Flash 5.0 

Released with Flash Player 5, new features included: ActionScript 1.0 (based on ECMAScript, 

making it very similar to JavaScript in syntax), XML support, Smartclips (the precursor to 

components in Flash), HTML text formatting added for dynamic text. 

Released with Flash Player 6, new features included: a video codec (Sorenson Spark), Unicode, 

v1 UI Components, compression, ActionScript vector drawing API. 

iii) Flash 6 in details:- 

Adobe Flash Professional is the successor of a software product known as 

FutureSplash Animator, a vector graphics and vector animations program released in 

May 1996. FutureSplash Animator was developed by FutureWave Software, a small 

software company whose first product, SmartSketch, was a vector-based drawing 

program for pen-based computers. In 1995, the company decided to add animation 

capabilities to their product and to create a vector-based animation platform for the 

World Wide Web; hence FutureSplash Animator was created. Initially, the only way 

to deploy such animations on the web was through the use of Java platform; however, 

the Java platform was later replaced with the Netscape's plug-in architecture. The 

FutureSplash animation technology was used on several notable websites such as 

MSN, the official The Simpsons website and Disney Daily Blast of The Walt Disney 

Company. In December 1996, Macromedia bought FutureWave and so re-branded 

and released FutureSplash Animator as Macromedia Flash v1.0. In 2005, Adobe 

Systems acquired Macromedia; subsequently, in 2007, Adobe Flash CS3 

Professional, the next version of Macromedia Flash was released. 



 
iv) Layers:-There are five types of layers you can use in Flash: 

• Normal layers contain most of the artwork in a FLA file. 

• Mask layers contain objects used as masks to hide selected portions of layers below 

them. For more information, see Using mask layers in the Flash documentation. 

• Masked layers are layers beneath a mask layer that you associate with the mask layer. 

Only the portion of the mask layer not covered by the mask is visible. 

• Guide layers contain strokes that can be used to guide the arrangement of objects on 

other layers or the motion of classic tween animations on other layers. For more 

information, see Guide layers and Create classic tween motion along a path in the Flash 

documentation. 

• Guided layers are layers associated with a guide layer. The objects on the guided layer 

can be arranged or animated along the strokes on the guide layer. Guided layers can 

contain static artwork and classic tweens, but not motion tweens. 

v) Drawing with flash:-  

The drawing tools in Flash let you create and modify shapes for the artwork in your movies. For 

an interactive introduction to drawing in Flash, choose Help > Lessons > Drawing in your Flash 

program.  

The tools for painting are kept in the "Tools" bar, usually positioned at the left top of your 

FlashScreen. On the following pages we will guide you through the use of each of these 

tools,starting with the simplest.But before going through the different tools, we will look at the 

way Flash handle drawings.The most important thing to understand is the distinction between 

outlines and fills.When you draw a line there is no fill - only the outline.When you draw a 

rectangle (or a circle) you actually draw two things: The outline (border) and the fill. Unlike 

most other programs, Flash doesn't automatically combine these two into one object. 

vi) Creating contents:-  

The possibilities are endless. 

Templates and components to kick-start any project. 



 
Incorporate virtually any kind of media. 

Easily edit and add special animation and timing FX. 

vii) Grouping shapes:- Whenever you have individual shapes, both their fills and strokes 

can be selected and moved individually. However, if you want to move them all 

together while maintaining their spatial relation to each other, it can be a bit of a pain 

trying to select them all at once repeatedly, and even more annoying to move them 

one at a time and then try to reposition them in relation to each other. What you can 

do, instead, is group them all together so that you only have to select them once. You 

can select all the objects that you wish to group by drawing a bounding box around 

them using the Arrow tool, or else by clicking on one before shift+clicking to select 

additional objects.  

viii) Types and text effects:-  

Adding an effect to your flash logo will help it looks more live. Today we will present a tutorial 

about how to add a Blur effect into a logo presentation. This tutorial will show you how to 

upload SWF file flash and embed flash files into Blogger so as to attract more visitors and boost 

your traffics in a short time.Then you can sharing with friends and family or share it on your 

Facebook. I bet you'll be agree with me if you see the flash photo gallery. Make text with effect? 

For someone who doesn't have any experience in flash, they will think that it's so difficult to do 

it. Now, I will show you how to make it easily. It does not take that long to create it. Placing the 

text along circle or ellipse is one of most common design tasks.In this tutorial, you will learn 

how to make text along the curve even more impressive by applying flash 8 bitmap filters such 

as drop shadow, bevel, glow and others. 



 
ix) Creating symbols and movie clips:- Use movie clip symbols to create reusable 

pieces of animation in Adobe Flash Professional. Movie clips have their own 

multiframe timeline that is independent from the main movie's Timeline—think of 

movie clips as mini-timelines nested inside a main Timeline that can contain 

interactive controls, sounds, and even other movie clip instances. You can also place 

movie clip instances inside the timeline of a button symbol to create animated 

buttons. In addition, movie clips are scriptable with ActionScript. To create a movie 

clip symbol, select the desired artwork on the Stage. Choose Modify > Convert to 

Symbol (or press F8). In the Convert to Symbol dialog box that appears, enter the 

name for the symbol, set the type to Movie Clip, and click OK. The movie clip 

symbol will appear in the Library. Drag an instance of the movie clip symbol to the 

Stage to use it in your project.After dragging a movie clip symbol from the Library to 

the Stage, name the movie clip's instance in order to identify it and use ActionScript 

to change its properties. 

x) Animating with flash:- In the Convert to Symbol dialog box you can type a name for 

your symbol, select from one of three behaviors and determine the registration point 

of your object: 

• Movie clip: Movie clips are dynamic, which means they can be targeted with 

ActionScript, the programming language of Flash. They can have any number of layers 

and frames, but their timelines are independent of all other timelines. Think of a solar 

system: each planet is a movie clip, looping endlessly and independently around a sun, 

which is the main Timeline. 

• Button: Buttons have four states: Over, Up, Down, and Hit. These are represented as 

keyframes in a button symbol's timeline. You can place graphics in any of these states 

and then apply ActionScript to the instance of a button to add interactivity to your Flash 

movie. 

• Graphic: Graphic symbols are very similar to movie clips with the exception that they 

are not dynamic and cannot be targeted with ActionScript. However, you can place a 

graphic symbol inside a movie clip symbol if the object needs to be dynamically 

controlled. Like movie clips, graphic symbols can have any number of frames and layers. 

Animators prefer to place entire animations inside a graphic symbol's timeline, allowing 

it to be controlled via the Property inspector in the parent timeline. The most important 

feature is that they will always be in sync with the main Timeline and all other graphic 

symbol's timelines. This is very important when trying to create frame-based 

animations—which is why most animators prefer working with graphic symbols for 

fixed-frame output formats (such as video). 

xi) Editing animation:- In this animation tutorial, I recommend using graphic symbols. 

This enables you to scrub the Timeline to see your animation play while inside the 



 
Flash authoring environment. The term scrubbing refers to the practice of moving the 

playhead back and forth manually to play the contents of the Timeline. The content in 

movie clip symbols do not play beyond Frame 1 unless you test your movie or 

publish it as a SWF file. 

Advanced Flash 

i) Interacting with flash:-You can make your application interactive using the MMI 

with Flash ActionScript. ActionScript enables you to set actions and control the 

properties of a flash movie. You can react to user actions in the control and send data 

from the Flash control to the screen, displaying it to the user. With ActionScript, you 

can set and retrieve device-dependent data, such as the device screen mode and 

volume level. You can use the device sensor and GPS input within flash content 

through the Accelerometer and Geolocation classes in ActionScript. You can also 

create additional interactivity by using the multi-touch feature. 

ii) Action Script & programming with action script:-  

Create, Build & Deploy Real Desktop Applications based upon the Adobe® Flash SWF Format. 

Zinc 4.0 compiles your SWF Files into Powerful Desktop Applications (Projectors) for 

Windows, Mac OSX and Linux. 

Create Stunning Commercial Applications, Screensavers, Widgets, Games, CD Roms, DVD's, 

Kiosks and More. Available for Windows & Mac OSX, Zinc 4.0 is the only X-Platform Rapid 

Application Development Tool for the Adobe® Flash Platform. 

iii) Flash & HTML 



 
HyperText Markup Language (HTML) is the main markup language for creating web 

pages and other information that can be displayed in a web browser. HTML is written in the 

form of HTML elements consisting of tags enclosed in angle brackets (like <html>), within 

the web page content. HTML tags most commonly come in pairs like <h1> (opening tag) and 

</h1>(closing tag), although some tags, known as empty elements, are unpaired, for example 

<img>. The first tag in a pair is the start tag, and the second tag is the end tag (they are also 

called opening tags and closing tags). In between these tags web designers can add text, tags, 

comments and other types of text-based content. The purpose of a web browser is to read 

HTML documents and compose them into visible or audible web pages. The browser does 

not display the HTML tags, but uses the tags to interpret the content of the page. 

You can make your application interactive using the MMI with Flash ActionScript. ActionScript 

enables you to set actions and control the properties of a flash movie. You can react to user 

actions in the control and send data from the Flash control to the screen, displaying it to the user. 

With ActionScript, you can set and retrieve device-dependent data, such as the device screen 

mode and volume level. You can use the device sensor and GPS input within flash content 

through the Accelerometer and Geolocation classes in ActionScript. You can also create 

additional interactivity by using the multi-touch feature. 

iv) Standalone players and projector :- you can export the banners you created with 

BannerSnack to SWF files, you might want to play them independently of your 

browser. The first thing you can think of is to download Adobe Flash Player. But 

since you used BannerSnack, that means you already have the flash player installed. 

However Adobe Flash Player won’t solve your problem, as it still uses a browser to 



 
play SWF files, and you need a player that would play the SWFs independently, 

right? Don’t search for “adobe swf player” as you will get this page. Dead 

end.However, Adobe has indeed such a SWF player, but, for our confusion (I had to 

ask my workmates from the flash department where can I find it), it is rather hard to 

find. It’s called Adobe Flash Player Projector Content Debugger (oh…) or Adobe 

Standalone Flash Player. 

v) Flash generator & flash generator server and template:- 

Despite the new capabilities that ActionScript has brought to Flash 4 and 5, the 

Flash Player plug-in still can’t directly import “raw” dynamic media at least not 

without a little help. That’s where Macromedia Generator 2 comes to the rescue. For 

example, if you want to dynamically insert or update bitmap graphics in Flash 

movies, then you need Generator. Generator can do a whole lot more, so without 

further ado, let’s get started. 

Many thanks to Mike Jones, who supplied the Generator information for the Flash 4 

Bible. Mike Jones is one of the original team members of Spooky and the Bandit, 

which is a Flash design and development team. 

 Generator Server 
As mentioned previously, if you want to serve Generator content you have to purchase and 

install the Generator Server application for your Web server. This is truly the Generator: It sits 

on your Web server, takes the templates (.SWT files) that you designed with the authoring 

extensions and published in Flash 5, applies the specified data sources that are used in the 

template, and then delivers a .SWF file (or another image format) to the user. See below for a 

diagram of this process. 

Generator is not only capable of producing interactive content solely based in Flash; the 

Generator Server application can also convert this Flash content (or any .SWT) into a .GIF, 

.JPEG, or .PNG image, or even a QuickTime Flash movie. Generator can also remove all 

textual elements from a .SWT file and its data source and save these elements to a standard 

text document. (Note, however, that Generator doesn’t format the text.) Generator can create 

image maps both client and server side. All of these items can be produced in either a “per-

user” (online), or a scheduled (offline), capacity. 

vi) Generator output window:-Template Explorer will automatically display an Output 

Window when you click the Generate button. The Output Windows' contents can be 

modified at any time which allows you to make changes anytime to the document 



 
 

vii) Site designing with flash 

Site Builder is the world's Favorite Flash Site Builder!  

Some of the reasons are: - 

 

a) Create stunning flash websites quickly and easily. 

b) In built gallery of flash templates that are designed by some of the top Flash Designers in the 

world 

c) Gallery of Flash Photo Albums 

d) Gallery of Media players for playing Video and Mp3 music 

e) highly engaging Flash Stores that come integrated with Paypal 

f) Simple point and click system for novices to highly advanced customization for seasoned 

designers. 

g) Extremely high level customizability with a large galleries of external elements like, graphics, 

text areas, image frames, buttons, icons etc. 

 

 

Text Books: 

  

i) i)                    HTML, DHTML & Javascript-Evan Bayross 

ii) ii)                   ASP in 21 days –Techmedia 

Reference Books: 

  



 
i) i)                    Dreamwearer in 21 days-Techmedia 

ii) ii)                   ASP 2.0 unleashed 

iii) iii)                 HTML 4.0 unleashed  

 


